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Background 

Section 508 of the Rehabilitation Act requires Federal agencies to make electronic and 
information technology (E&IT) accessible to users with disabilities, including: 

• Blindness, color blindness, visual impairment 

• Deafness, hearing impairment 

• Speech impairment 

• Mobility, strength, dexterity or reach impairment 

The law includes standards for software applications, operating systems (OS), web-based 
applications and multimedia. These standards apply to files made available in the portable 
document format (PDF). PDF is often used as a way to preserve a document’s look and feel 
across a wide variety of platforms, as well as to add protection against alterations. 
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Those involved in the design, distribution and use of PDFs are responsible for ensuring that 
they comply with Section 508, but it may not always be clear how to do so. 

Purpose 

The goal of these tutorials is to enable developers and other personnel involved in PDF 
creation and distribution to apply principles of accessibility to ensure materials are Section 
508-compliant, whether the documents are used for official communication, eLearning 
course content components or other purposes. 

These tutorials reference commercial products likely to be familiar to those taking the 
course. References to commercial product functionality and providers are included to 
illustrate the application of techniques described, and are not intended as either 
endorsements or critiques of specific providers or products. 

PDF Accessibility 

For PDFs to be 508 compliant, they need to be tagged. Tagged PDFs allow various assistive 
technologies (AT) to interact with the content of a document and make sense of it. There is 
no automated solution for creating accessible PDFs. 

The most effective way to begin the process of making a PDF accessible is to create a 
document directly from an authoring application that produces tagged PDFs, such as 
Microsoft Word, and then convert it to PDF format.  

To complete the process of making a document accessible after conversion, it will usually be 
necessary to touch up the tagging and reading order. There are a number of software 
products available to help with this process. They include: 

• Adobe Acrobat 

• NetCentric Technologies CommonLook 

• Nuance PDF Converter 

In order to focus on a consistent approach to making PDFs accessible, these tutorials 
assume that you are using Adobe Acrobat. It produces reliable, accessible results, and is 
frequently used by VA personnel. 

While Adobe Acrobat Standard software offers some features for making existing PDF files 
accessible, Adobe Acrobat Pro software has additional features to allow you to edit reading 
order and document structure tags for documents with complex layouts, like forms or 
tables. 
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Regardless of which software you use, you will need to be sure that your document is 
structured and tagged correctly. 

These tutorials will show you how to use Adobe Acrobat X Pro to make documents 
accessible by ensuring that the tagging and reading order are correct, and that other 
accessibility requirements have been met. Steps for using Adobe Professional X are 
provided; however, the information is often applicable to users of Adobe Professional 9 and 
earlier versions as well. 
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Preparing Scanned Documents 

Scanned documents come in a variety of shapes and sizes and from a variety of sources. 
There are whole documents, small sections (such as a signature), handwritten notes and 
others. No matter the size of the scanned portion, it should be made accessible to all users. 

Most of the time, a document scanned directly to PDF will not be accessible. Generally, the 
PDF produced from scanning is just an image of the text in that document. Without proper 
accessibility techniques, ATs such as screen readers cannot identify the contents of an 
image. 

How to Tell if a Scanned Document is Accessible 

It is fairly easy to tell if a PDF contains text or is just an image. Check by performing one of 
the following: 

1. Recommended Approach: Run the Accessibility Quick Check under the Document 
menu. If the results dialog reports that “The document appears to contain no 
text. It may be a scanned image,” the document is not tagged and structured for 
accessibility. 
 

 

2. Use Adobe Reader’s Read Out Loud feature, found under the View menu. If it 
says the document is empty, then the document is likely an image and not real 
text. 

3. Try to select the text with the mouse pointer. If the text cannot be highlighted by 
itself, the document is an image. 

What to Do with a Scanned Image 

The first step for turning scanned documents into actual text is to go through an Optical 
Character Recognition (OCR) process, which turns the images of words into actual text on a 
page. Once a document has been run through the OCR process: 
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1. Check the document’s accuracy to ensure it is formatted appropriately, correcting 
scan errors, as needed. 

2. Navigate to Tools > Accessibility and select the Add tags to document option. 

By completing these steps, Acrobat gives the document content structure. Adding tags to 
the document can only interpret a left to right, top to bottom reading order; therefore, a 
little remediation is necessary to correct structural issues such as lists, tables, links, 
headings, etc. 

If the OCR process cannot be performed for some reason, then the other option is to 
provide alternate text for the document image (as you would for any other complex image). 

Text should either be placed in the alternate text field of an image’s properties dialog or as 
text content within the document (either near the scanned image or as an appendix). 
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Ensuring Proper Page Structure 

There are several types of structural elements that aid in navigation and organization of PDF 
documents. Providing structure helps all users understand the content in the document. 
Moreover, structure allows users of AT to navigate using AT-specific commands to jump to 
or skip content. 

Getting Started 

The most important step to begin creating an accessible document is to ensure that the 
document contains a tag structure. Tag structure can be checked  by running the 
Accessibility Quick Check under Tools > Accessibility > Quick Check in Acrobat X or by 
opening the tags panel and confirming there is “No Tags available” message. Access the 
Tags pane through the menus by navigating to and activating the View > Show/Hide > 
Navigation Panes > Tags options. 

 

If it is confirmed the document does not contain a tag structure, tags can be added to the 
document in Acrobat X by navigating to and activating Tools > Accessibility > Add tags to 
Document. 

Managing Headers and Footers 

Headers and footers contain important pieces of information that need to be readable by all 
users. However, when users of screen reading technology hear this content, it can be 
confusing to discern which information is part of the main page content versus the 
header/footer information. 

 

The example above shows how, depending on the context of the content, it could be 
confusing to understand the point being conveyed by the information. The image shows a 
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document that has a sentence that breaks across pages. The page content shown 
improperly reads “...Computer paper was bought in quantities of 10 300 pound crates…” 
The correct information and intention of the sentence is misconstrued when read in that 
order. The sentence should read “...Computer paper was bought in quantities of 300 pound 
crates…” Therefore, header/footer content needs to be placed appropriately in the reading 
order or made an artifact. 

Non-unique header/footer content, for example, the repeated company name on each page, 
needs to be tagged only on the first page. It is recommended to leave the content visually 
on the page, but to tag the repeated content as an artifact. For more information about 
tagging artifacts, see the Hiding or “Artifacting” Non-Meaningful Content tutorial. For unique 
content such as notes, footnotes, remarks, etc., the content needs to be placed 
appropriately in the reading order. 

Dealing with Watermarks 

If not tagged properly, watermarks can be misconstrued as content in a document when 
read by ATs. When watermarks are inserted in source documents, the watermark content 
sometimes gets tagged as content on each page of the document. It is best to avoid 
watermarks, but if they are needed they should be added from within Acrobat so that the 
watermark is properly tagged. 

When adding watermarks in Acrobat, document authors need to be mindful of the color 
contrast of the watermark. By selecting an appropriate shade of color and adjusting the 
opacity, watermarks will not conflict with page content. For more information on this topic, 
refer to the Using Color tutorial. 
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To add or update a watermark in Acrobat X: 

1. Navigate to and activate Tools. 

2. Navigate to and expand Pages. 

3. Under Edit Page Design, activate the Watermark link. 

4. Locate and activate Add Watermark… or Update… 

5. Confirm the Add Watermark/Update Watermark dialog appears. 

For text watermarks, the font color and shade of the text can be changed through the color 
picker button. 

For both text and graphic watermarks the opacity can be changed with the opacity slider or 
by editing the percentage next to the slider control. 

Modifying an Element Type 

If a tag is not properly identified, it needs to be changed so that the contents below it will 
be properly identified by ATs. This will ensure that all the correct options are available for 
modifying the content within the document. 
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For example, bigger, bolded text is sometimes identified as a paragraph in the tag 
structure, but to provide proper hierarchical information to the user, the tag needs to be 
structured as a heading. 

To change a tag’s type through the properties dialog: 

1. Ensure the tag in question is selected in the Tags pane. 

2. Activate the Context menu of the tag and select Properties from the options. 

In the TouchUp Properties dialog box, select the proper element from the Type 
combo box. 
 

 

3. Select the Close button and verify the tag type has changed in the Tags pane. 

To change a tag’s type even if the Touchup Properties dialog is grayed out: 

1. Ensure the tag in question is selected in the Tags pane. 

2. Press F2 on the keyboard. 

3. Confirm the tag has become editable.  

 

4. Type the desired name of the tag.  
Note: The Tag name must be exactly the same as the name Acrobat uses so that it 
maps to the proper element in the Role Map (so that the Role Map does not need to 
be modified). 

Controlling Reflow 

For low vision and mobility impaired users, it is important to check that the document flows 
properly, in the way originally intended, after any editing or formatting changes. 
“Reflowing” will eliminate horizontal scrolling in a document. If low vision users need to 
zoom-in to read a document, once it is reflowed they do not have to worry about horizontal 
scrolling to see all the content. 
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Properly structuring elements in the Tag tree affects the reflow of documents. It is 
important to check that content is in the proper reading order and contained within 
appropriate tags. For example, if a table is under a figure tag in the Tags pane, the table 
will not reflow properly. Some tags, such as figures, will not allow the content to be 
zoomed-in. 

A document can be reflowed by navigating to View > Zoom > Reflow in the menu structure 
or by using the CTRL + 4 keyboard shortcut. 

In the image below, a sample section of a document is shown in a side-by-side comparison 
of how the table and text in the document would look when it is not reflowed and when the 
reflow option is applied. The top part of the image shows the document not using reflow. 
When reflow is not used, text flows off the page to the right and a horizontal scroll bar that 
appears in the viewing application is necessary to read the rest of the content on that page. 
However, when reflow is applied (the bottom half of the image below) text is wrapped 
around to a new line to prevent a horizontal scroll bar from appearing. While the reflowed 
text may seem more difficult to read, not having to horizontally scroll a page is a major 
consideration for mobility impaired and low vision users. 
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Tagging for Logical Reading Order 

It is important to keep in mind the reading order of objects in a document. ATs interpret a 
page based upon its structure. The order in which content is laid out visually on the page is 
the order in which it needs to be displayed to ATs. 

The Tags Pane 

The Tags pane and Order pane show the order in which the content will actually be 
displayed. It is best to only manipulate the tags in the Tags pane. The Order pane does not 
always update the content in an accessible manner. The Tags pane also shows the type of 
content contained in the document. For instance, properly structured headings, lists and 
tables will have corresponding structural tags in the Tags pane. 

 

The graphic above shows how tags can be switched around. If the order of the tags in the 
Tags pane is not the same as the visual layout of the document, ATs cannot read the 
content properly. 

Changing Reading Order 

In the example above, the <H2> tag containing “Introduction” should be placed above the 
paragraph tag containing “Proper structure of…” 

• To change the reading order, drag (or copy and paste) the <H2> tag above the 
paragraph tag. Once the order of the content matches the implied visual layout, AT 
users can accurately interpret the content. 

Verifying Reading Order without Using AT 

• To verify the reading order of a document without using assistive technologies, open 
the Tags pane and activate the Context menu of any text. 

• On the Context menu select Highlight Content. 
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• Use the arrow keys on the keyboard, arrow up or down, and notice the blue 
rectangle around the content in the main content area of the document. The area 
highlighted by the blue rectangle is content that the currently selected tag in the 
Tags pane references. Expand all tags to see the order of each item in the document. 

• Note: Be sure to return to the Context menu and unselect Highlight Content when 
finished viewing the order. Leaving Highlight Content selected will make other 
options unusable. 
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Providing Alternate Text for Images 

It is important to add alternate text to significant images so that users of AT will receive the 
same information that other users do. 

Ensure that alternate text is meaningful so that it clearly conveys the purpose of the image. 

How to Apply Alternate Text to Images 

Alternate text can be applied in the Alternate Text: field of the TouchUp Properties dialog. 
TouchUp properties can be accessed by selecting Properties on the Context menu of the 
desired Figure tag. 

Simple Images 

Meaningful and concise alternate text should not be more than 255 characters. Note that in 
the example below the alternate text being applied to an image that says "Red Balloon" is 
more descriptive than "Balloon" as alternate text. 
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Alternate text can also be added or edited for an image using the TouchUp Reading Order 
(TURO) tool. To add or edit the alternate text of an image using the TURO: 

1. Activate the TouchUp Reading Order tool. 

a. In Acrobat 9 it can be accessed via the toolbar icon  or through the 
Advanced > Accessibility > TouchUp Reading Order menu selection. 

b. In Acrobat X it can be accessed through the Tools > Accessibility > TouchUp 

Reading Order panes and selecting . 

2. In the main document, locate the image that needs alternate text or edits to the 
alternate text. 

3. Activate the Context menu of the image and select Edit Alternate Text from the 
menu. 

4. In the Alternate Text dialog, make the necessary changes or additions. 
 

 

5. When finished, locate and activate the OK button. 

6. Repeat steps 1 through 5 as many times as necessary. 

7. Note the changes or additions to the alternate text on the image in the main 
document. It may be necessary to view the TouchUp Properties dialog of a tag in 
the Tags pane to see the full alternate text for an image. 

To see whether an image has alternate text applied or not, select Properties, then on the 
Context menu of an image in the Tags tree and review the contents of the Alternate Text 
edit field. Alternate text also appears next to an image when the TURO tool is active, or it 
will say the image has no alternate text. 

Complex Images 

For complex images, charts and diagrams that need longer descriptions than alternate text 
can provide (255 characters or less), text should be placed in-line, in a footnote or in an 
appendix to appropriately describe the image. When a description is provided within a 
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footnote or appendix, a link should be provided from the image or caption of the image to 
the description. 

Decorative Images and Remnants 

Decorative images and drawing remnants should be turned into artifacts to guarantee they 
do not interrupt the flow of important information. Sometimes process lines, arrows, 
borders and other shapes are not automatically converted as artifacts. These items can be 
changed into artifacts by locating the object in the tag tree and selecting Change Tag to 
Artifact, on that object’s Context menu. 

When in doubt, add alternate text to ensure all users receive information. 

Element Type 

It is important that graphics and images are identified as the correct element types in the 
tag properties. The parent tag of the actual image tag will indicate the type of element that 
will be identified by ATs. If the incorrect type of element is identified, the content may not 
be presented in a meaningful manner to the AT user. An image or graphic should have a 
Figure type tag as its parent tag. 

To change the type of the tag, activate the Context menu of the parent tag and select 
Properties, in the TouchUp Properties dialog, select Figure from the Type combo box. 

 

The TURO tool can also be used to identify the type of element. To structure content as an 
image using the TURO tool: 

1. Select graphic or image in the main document. 

2. Activate the TURO tool. 

a. In Acrobat 9, it can be accessed via the toolbar icon  or through the 
Advanced > Accessibility > TouchUp Reading Order menu selection. 

b. In Acrobat X, it can be accessed through the Tools > Accessibility > TouchUp 

Reading Order panes and selecting . 
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3. In the TouchUp Reading Order dialog, activate the Figure button. 
 

 

4. Repeat steps 1 through 3 as many times as necessary. 

5. Review the Tags tree to ensure a figure tag was placed as the parent tag to the 
image. Alternatively, a screen reader can be used to confirm the content is 
identified as an image. A screen reader will likely preface the figure’s alternate 
text with “graphic”. 
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Hiding or “Artifacting” Non-Meaningful Content 

Creating artifacts in Acrobat can be crucial to the accessibility of a PDF document. There are 
times when content on a page is used to visually cause an effect (separation, borders, 
decoration, etc.). However, when these items are exposed through the tag structure to 
assistive technology users, it can be quite disruptive. Hiding or changing content to be an 
artifact (the term used within Adobe Acrobat) can help ensure that only meaningful content 
is detected by ATs. 

Examples of content that should become artifacts are unmarked content, drawing remnants, 
decorative images, redundant and duplicate information repeated on every page, such as 
header or footer content, line spacers and other content that is meant to be visually 
appealing, but not to provide pertinent information. Any tagged content that is not tagged 
as an artifact will be indicated by ATs. 

Creating an Artifact 

There are two ways to artifact or hide content from screen readers. 

Recommended Approach: Change the content to an artifact through the Context menu 
options of a particular tag in the Tags tree. 

1. Find the content in the Tags tree that needs to be hidden. 

2. Activate the Context menu of that specific tag. 

3. Select Change Tag to Artifact... from the menu options. 
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4. Select the OK button in the Create Artifact dialog. 
 

 

5. Repeat steps 1 through 4 as many times as necessary. 

6. Check that the text and/or remnants are not present in the document by 
highlighting the content in the main document and selecting Find Tag from 
Selection on the Context menu of any tag in the Tags tree. A dialog box should 
pop up stating that the selection was not found. Alternatively, a screen reader 
can be used to read through that section of the document to ensure the content 
is hidden. 

The second method to hide or artifact content is to use the TURO tool. 

1. Select the content in the main document that needs to be hidden from ATs. 

2. Activate the TURO tool. 

a. In Acrobat 9 it can be accessed via the toolbar icon  or through the 
Advanced > Accessibility > TouchUp Reading Order menu selection. 

b. In Acrobat X it can be accessed through the Tools > Accessibility > TouchUp 

Reading Order panes and selecting . 
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3. In the TURO dialog, activate the Background button. 
 

 

4. Repeat steps 1 through 3 as many times as necessary. 

5. Check that the text and/or remnants are not present in the document by 
highlighting the content in the main document and selecting Find Tag from 
Selection on the Context menu of any tag in the Tags tree. Alternatively, a screen 
reader can be used to read through that section of the document to ensure the 
content is hidden. 

Revert an Artifact Back to Tagged Content 

If the content needs to be tagged again in the future, or something was changed to an 
artifact by mistake, there are three ways to unhide the content. 

1. Select the content in the document. Then using the Tags panel, choose Create 
Tags from Selection on the Context menu of any tag. It is best to create the tag 
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near the location where the content needs to be read. It will be easier to verify 
the reading order of the content. 

2. After selecting the content in the document, use the TURO tool and activate the 
button for the correct tag type from the buttons listed in the TURO dialog. 

3. Activate the Context menu of any tag in the Tags pane. 

a. From the Context menu, select Find… The Find Element dialog will appear. 
Artifacts should be selected by default in the Find combo box. 

b. Select the Search Document radio button in the dialog. 

c. Activate the Find button in the dialog. Notice a blue rectangle will be placed 
around the artifact in the main content area. 

d. Activate Find Next in the Find Element dialog until the desired artifact is 
highlighted and then activate the Tag Element button. 

e. Ensure the tag is placed in the proper order in the Tags pane. 
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Using Headings to Provide Structure 

Structured heading elements help users understand how information is organized, and allow 
them to navigate quickly to specific content. Headings should be unique and descriptive. 
Generally headings are short phrases that may be displayed in a larger font size, different 
font style and/or in bold text. 

Headings should be structured with H1-H6 heading levels applied uniformly without skipping 
levels. It is important to organize content in a meaningful manner; therefore, any sections 
that have sub-sections need to be labeled at a lower heading level. 

For example, if the “About” page of a website had “The People” as bolded text, it would 
indicate a heading; therefore, it should be structured as an H1 (Heading Level 1). If under 
that H1 heading there were the bold phrases “The Teachers” and “The Students”, both of 
these phrases would need to be structured as H2 (Heading Level 2) to indicate that they 
belong to the main section about “The People” versus a different main section about “The 
Building”. 

Best Approach: Using Acrobat, heading structure can be applied through the TouchUp 
Properties Type combo box. Access the TouchUp Properties through the Context menu of 
any tag and select Properties. 

 

The TouchUp Reading Order tool can also be used to designate text as headings for heading 
levels 1-3. In Acrobat X, access the TouchUp Reading Order tool through Tools > 
Accessibility > TouchUp Reading Order options. 

It is important to also apply headings to index and glossary sections. Applying headings to 
these areas will help assistive technology users jump to pertinent information without 
having to read other content. 
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Building a Proper List Structure 

It is important that related list items be structured as a list to allow AT users to efficiently navigate 
the content. List structures help assistive technology users to identify and understand the 
relationship items have to each other. 

Only symbols that are commonly recognized as list bullets should precede list descriptions. 
Inappropriate symbols may confuse assistive technology users when determining list content. For 
example, smiley faces or the registered symbol are not meaningful as bullet identifiers. If it is not 
possible to use a meaningful symbol, authors need to apply custom text to the symbol in the 
alternate text field of the symbol’s parent tag. 

Structure of Lists 

Think of the structure of lists and list items as a family tree. There are the parents, which are the 
main list items. Then there are the children, or sub-lists, under one parent item. All list items 
contained at the same level can be thought of as siblings. In Adobe Acrobat, each list structure 
must consist of a parent <L> tag and subsequent list item <LI> tags for each item in the list. If 
there are total of eight fruits listed, then there needs to be eight <LI> tags in the structure. Each 
list item <LI> tag must contain a label <lbl> tag that includes the number or bullet and a list item 
body <LBody> tag that contains the text of the item. Below is an example of proper list structure: 

Example List: 

• Oranges 
• Grapes 
• Apples 

Example List Structure: 
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A sub-list must be structurally under, as a child, the list item to which it is related. It is placed after 
the text of the parent list item. Below is an example of a sub-list structure: 

Example sub-list: 

1. Oranges 
2. Grapes 
3. Apples 

a. Granny Smith 
b. Orchard 
c. Sour Apple 

4. Strawberries 
5. Cherries 
6. Cantaloupe 

Example sub-list structure: 
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Pay attention to lists that span across multiple pages. Even though a list continues on to another 
page, it is important that in the tag structure those list items are part of the original list and not a 
list of their own. Attention to detail of these items enables users to associate related content and 
know the total number of related items. 

Creating a List in the Tags Pane 

Below are the steps to begin creating a list using the Tags pane. 

1. Select the first list item in the main document. 

2. In the Tags pane, activate the Context menu of any tag and select Find Tag from 
Selection. 

3. Locate the highlighted tag in the Tags pane and identify whether the content is already 
encased in a list structure by locating an <L> tag with <LI> tags below it. 

a. If a list structure does exist, verify all the components (<L>, <LI>, <Lbl> and 
<LBody>) are present and each list item is shown individually in its own tag. If some 
but not all of these factors are present, follow the steps for the missing tags as 
described for each below. 

b. If a list structure does not exist, you may find the visually implied list text contained 
underneath a <P> (paragraph) tag or some other type of tag. Paragraph is a 
common example case. 

4. Activate the Context menu of the parent tag of the list item text, such as the <P> tag. 

5. Navigate to and select Properties... 

6. From the Type combo box on the Tag tab, select List. 

7. Navigate to and activate the Close button. 

8. Next a list item tag needs to be added as a child of the list <L> tag. To get the <LI> tag 
at the correct level, locate the text of the list item in the Tags pane and activate the 
Context menu of the tag. On the Context menu, select New Tag… 

9. In the New Tag dialog, select List Item from the Type combo box. 

10. Navigate to and activate the OK button. 

11. Verify that an <LI> tag appears directly under the list item text tag. 

12. Now a label tag needs to be added to hold the bullet of the list item. Select the <LI> tag 
and activate the Context menu. 

13. Select New Tag... from the options. 

14. In the New Tag dialog, select Label from the Type combo box. 
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15. Navigate to and activate the OK button. 

16. Confirm a <Lbl> tag now appears as a sibling in the tree to the <LI> tag. 

17. Next create a list body tag to hold the text of the list item. Select the <LI> tag and 
activate the Context menu. 

18. Select New Tag... from the options. 

19. In the New Tag dialog, select List Body from the Type combo box. 

20. Navigate to and activate the OK button. 

21. Confirm a <LBody> tag now appears as a sibling in the tree to the <LI> and <Lbl> 
tags. 

22. With the <Lbl> tag highlighted, drag it beneath the <LI> tag, so that it becomes a child 
of the <LI> tag. An arrow pointing right with a horizontal line to the right side should 
appear to help identify at which level the tag is being placed. 
 

 

23. Repeat the previous step to move the <LBody> tag beneath the <LI> tag. The <Lbl> 
and <LBody> tags should become siblings under the <LI> tag. 
 
Note: It is important to ensure the <Lbl> tag is above the <LBody> tag so that the 
bullet will be read before the text of the item. 

24. The bullet and text need to be separated so that they can go under their respective 
tags. In Acrobat X, activate the Edit Document Text tool under the Tools option on the 
toolbar. Place the cursor directly after the text of the item. The text should be 
highlighted, but not the bullet. 

25. In the Tags pane, locate the tag of the selected text and activate the Context menu of 
the tag. 

26. On the Context menu, select Create Tag from Selection. 

27. Verify that in the Tags tree the bullet item is contained in a separate tag from the text of 
the list item. 
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28. Similar to one of the previous steps, select the tag that contains the bullet and drag it 
beneath the <Lbl> tag so that it becomes a child of the <Lbl>. 

29. Select the tag containing the text of the list item and drag it beneath the <Lbody> so 
that it becomes a child of the <LBody>. 

30. It is important to verify the structure of the tags to ensure proper reading order. Verify 
that under the <L> tag there is a <LI> tag at the first nesting level. Then verify that 
beneath the <LI> tag the <Lbl> and <LBody> tags are at another nested level. Ensure 
the <Lbl> tag is above the <LBody> tag. Verify that the bullet is nested under the 
<Lbl> tag and that the text of the list item is nested under the <LBody>. 
 

 

31. Repeat the steps above to place the content correctly under each list item. 

32. Ensure that each list item <LI> tag is at the same level (siblings). Example: If there are 
three items in a list, there needs to be three <LI> tags under one <L> tag. 
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Making Tables of Contents Accessible 

Table of content (TOC) structures aid in intra-document navigation and content relation. 
TOCs have the same basic structure as a list; the main difference is that the tags are 
defined differently. 

Planning the Structure of TOCs 

Table of contents items need to be structured with <TOCI> tags nested under a parent 
<TOC> tag. Beneath the <TOCI> tag the item description, leader and page number need to 
be present. 

It is recommended that lengthy documents (20 or more pages) contain a linked table of 
contents. For linked TOCs, each table of content item (TOCI) needs to contain a 
<Reference> tag. A <Link> tag needs to be placed as a child element under the 
<Reference> tag so that the item is associated to a content type. Underneath the <Link> 
tag the item description, leader, page number and Link - OBJR tag (which allows for 
keyboard accessibility) need to be present. 

 

To organize the content in the tag tree, each segment of the <TOCI> should be separated 
into its own tag. The segments can be created by highlighting the desired text in the 
document and selecting Create Tag from Selection on the Context menu of the tag in the 
Tags pane directly above where the tag is to be placed. 

Applying the TOC Structure 

Creating a table of content structure is very similar to creating a list structure. For the 
purposes of this tutorial, focus will be on creating a linked tabled of contents. Below are the 
steps to create a TOC structure in the Tags pane. 

1. If there is a heading, such as Table of Contents above the TOC items, select it in the 
main document. 

a. In the Tags pane, activate the Context menu of any tag and select Find Tag from 
Selection. 
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b. The heading may be contained within part of the TOC structure. If it is, it needs 
to be moved above the parent <TOC> tag and defined as a heading. 
 

 
Change the <TOCI> tag to a heading by activating the Context menu of the tag 
and navigating to Properties. In the Type combo box on the Tag tab, select an 
appropriate heading level and then close the dialog. 

2. If there is no heading above the content items, select the first list item that is part of 
the TOC in the main document. 

3. In the Tags pane, activate the Context menu of any tag and select Find Tag from 
Selection. 

Locate the highlighted tag in the Tags pane and identify whether the content is 
already encased in a TOC structure by locating a <TOC> tag with <TOCI> tags 
nested below it. 
 
If a TOC structure is found, it will likely need some remediation efforts. For example, 
one possible structure found after conversion from an authoring tool presents a 
<TOC> tag with a nested <TOCI> tag, a further nested <Reference> tag, the item 
content, leader and page number contained as one item under the <Reference> tag, 
and finally a Link-OBJR tag as a sibling tag to the item content tag.  
 

 

4. To remediate the structure for the first item in the TOC that already has a <TOCI> 
tag, ensure a <Reference> and <Link> tag are both present as children tags under 
the <TOCI> tag. 

5. If either or both the <Reference> or <Link> tags do not exist, activate the Context 
menu of one of the tags nested beneath the <TOCI> tag (such as the content item 
tag) and select New Tag… 

6. In the New Tag dialog, select Reference or Link from the Type combo box. 

7. Navigate to and activate the OK button. 

8. Repeat the above steps to add another tag if necessary. 
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9. Verify all the pieces are available to start organizing the structure of a content item. 
A TOC, TOCI, Reference, Link, content item and Link-OBJR tags need to be present. 

10. If necessary, highlight the <TOCI> and drag it to become a child of the <TOC> tag. 
An arrow pointing right with a horizontal line to the right side should appear to help 
identify at which level the tag is being placed. 
 

 

11. If necessary, highlight the <Reference> tag and drag it to become a child of the 
<TOCI> tag. 

12. If necessary, highlight the <Link> tag and drag it to become a child of the 
<Reference> tag. 

13. If necessary, highlight and drag the content item, leader and Page Number tag(s) to 
be children of the <Link> tag. 

a. If the content item, leader and page number are grouped as one tag, they need 
to be separated. To separate the pieces into three separate tags, select the 
content item in the main document. 

b. Find the tag containing the content item in the Tags tree and activate the Context 
menu of the tag. 

Select Create Tag from Selection on the Context menu. 
 

 

c. Verify the content item is contained in an individual tag. 

d. It is likely easier to select the page number than the leader. Therefore, the next 
step is to select the page number in the main document. 
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e. The page number may not be visible as part of the tag in the tag structure, but 
find the tag near the content item that was just separated that contains the 
leader and activate the Context menu of the tag. Select Create Tag from 
Selection on the Context menu. 

f. Verify the page number is now contained by itself in a tag. The leader should now 
also be the only thing in its tag. 

g. Arrange the tags in the following order: content item, leader and then page 
number as children tags under the <Link> tag. This sequence will ensure the 
content is in the proper reading order. 

14. Ensure that the content item, leader and page number are above and a sibling to the 
Link-OBJR tag. 

The final structure of the TOCI item should be TOC, TOCI nested one level, Reference 
nested under TOCI, Link nested under Reference, and the content item, leader, page 
number, and Link-OBJR nested under the Link tag. 
 

 

15. Repeat the steps above to structure the other TOCIs. 

16. Verify that all the <TOCI> tags are at the same level (siblings) in the tag structure. 
 
To properly structure a non-linked table of contents <Reference>, <Link> and Link-
OBJR tags need to be omitted from the tag structure. The structure needs to be 
<TOC>, nested <TOCI> and beneath the <TOCI> nest the contents item, leader, 
and page number as individual tags. 
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Adding Bookmarks 

Bookmarks are an important navigational tool for all users. AT users rely on navigational tools, 
such as bookmarks, to jump within documents to specific sections. Bookmarks need to be placed in 
documents with 20 pages or more and need to closely follow the structure of the table of contents, 
if it exists. At the very least, bookmarks need to follow the order of the structured headings in the 
document. 

Bookmarks can easily be added through the Bookmarks pane. 

1. Navigate to the page in which a bookmark needs to be placed. 

2. Highlight the text in the main document that is the desired bookmark. 

3. In the Bookmarks pane, on the Options menu, select New Bookmark. 
 

 

4. Verify that the highlighted text was added to the list of bookmarks. 

5. Ensure the order of the bookmarks in the list is the same order in which they appear 
throughout the document. 
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Creating Accessible Links 

Links are important navigational tools that authors use to provide more information or 
resources. There are several factors that make links accessible and more meaningful to all 
users. 

Keep the following in mind when considering providing links in materials: 

• Apply meaningful link text when naming a link. Meaningful is defined as short, 
concise and purposeful. A link needs to describe the content behind the link or the 
action that will occur by activating the link. 

• Avoid using generic terms such as click here, read more, more information. It is not 
a good idea to require users to follow links to determine their meaning. It is not 
always easy for AT users to return from the link destination to the original content. 

• When possible, instead of leaving the link text as a raw URL, mask it with 
appropriate alternate text so that AT users can more easily determine its purpose. 
Often URLs do not provide helpful clues to the content to which they lead. 

• Links must be structured properly so that they are identified as actionable items to 
AT users and so that they are accessible via the keyboard. Every active link needs to 
structurally contain a <Link> tag and a Link-OBJR tag. The <Link> tag identifies the 
type of element and the Link-OBJR tag allows the link to be tabbed to and activated 
by the keyboard. 

• Ensure links pointing to different locations have distinctive text. For example, 
multiple “visit us” links on a restaurant’s website that listed its various locations 
would not efficiently allow AT users to discern the target of the link. 

• Link text needs to contain more than three characters. Link text that is too short can 
be difficult for AT users to identify. Glossary entries are common exceptions to this 
practice. 

It is also important to understand how the target location of the link will impact ATs. For 
example, linking to an external website that the document author does not maintain can be 
dangerous. The document author has no control over the accessibility of the website. 
Additionally, intra-document links can be a problem for AT users. There are limitations of AT 
and PDFs that do not allow for the target area, or anchor, to be recognized. For a mouse 
user, clicking a link may appear to take the user to an exact target and put it in view; 
however, screen reader users will not know exactly where the target is because PDF only 
allows targets to a visually defined area of a page. AT users will know which page they 
jumped to, but they will not know where to look for the target information. 

Structure of a Link 

The <Link> tag has a role of link; therefore, it is identified to AT users as a link. Having the 
proper role identified is important because then AT users can determine how to interact with 
the content. For a link to be structured and identified properly there needs to be a <Link> 
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tag with the tag containing the link and link text as a child of the <Link> tag and with a 
Link-OBJR tag as a sibling to the Link Text tag. 

 

To ensure an actionable link is given the proper role: 

1. Locate the tag containing the visual link text in the Tags pane. 

2. Highlight the parent tag of the link text. 

3. Press F2 on the keyboard and type <Link>; OR, 

4. Activate the Context menu of the parent tag, select Properties and select Link 
from the Type combo box in the TouchUp Properties dialog. 

5. Confirm there is a <Link> tag as a parent tag to the link text and Link-OBJR 
tags. 

To add the Link-OBJR tag to a link for keyboard accessibility: 

1. Locate the tag containing the visual link text in the Tags pane. This will allow the 
tag to be placed in relation to its link text. 

2. Activate the Context menu of the Link Text tag and select Find… 

3. In the Find Element dialog, select Unmarked Links from the Find combo box. 
 

 

4. Navigate to and activate the Find button. 

5. When the link in question is highlighted in the main document by a blue 
rectangle, navigate to and activate the Tag Element button. 

6. Navigate to and activate the Close button. 

7. Confirm a Link-OBJR tag has been placed as a sibling tag to the Link Text tag. 
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Applying Alternate Text to Links 

Whether the visual text or a raw URL link needs to be updated, alternate text can be applied 
so that the AT user will be able to access more useful information. Alternate text for links is 
just as easy as adding alternate text to other elements, such as images. 

1. Select the link in the main document that needs to be updated. 

2. In the Tags pane activate the Context menu of any tag and select Find Tag from 
Selection. 

3. Verify the tag containing the visual link text is highlighted. 

4. Activate the Context menu of link text and select Properties. 

5. In the TouchUp Properties dialog, place meaningful alternate text in the Alternate 
Text edit field. Meaningful and concise alternate text should not be more than 
255 characters. 
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Using Color in an Accessible Way 

Color is important to any design. Color can help draw attention, enhance an experience, 
designate groups and convey other valuable characteristics. Applying the following 
principles will ensure appropriate uses as designers and document authors continue to use 
color in products. 

There are two main concepts to consider within the topic of color. First, do not use color 
alone to convey meaning. Anytime color is going to be used for emphasis, an additional 
form of textual representation should also be provided. Second, ensure the contrast 
between foreground and background colors, of text and images, provides a sufficient 
amount of difference that users do not struggle to see the content. Color contrast issues can 
affect any user, and if the contrast level is not high enough, they may skip over content. 

Avoiding the Use of Color Alone to Convey Meaning 

There are many common examples of where color is used to convey meaning, but there are 
appropriate alternatives to all of them. Authors should apply these examples to content and 
avoid using color to distinguish information that is not conveyed in an alternative format. 

• Form elements – Any required fields need to have an asterisk (*) near it or some 
other symbol indicating that it is required. Instructions including a key indicating 
what symbols mean should be at the beginning of a form. 
 

 

• Images – A weather map or a map of regions needs to have meaningful alternate 
text that supplies the areas included in each alert or section of the map. A building 
layout image may use color to indicate areas in which the public is allowed; this type 
of information would need to be included in the alternate text of the image. 

• Text – Often important text or instructions are called out visually by being placed in 
colored boxes or text is bolded to create emphasis or importance. These significant 
pieces of text need to have a textual word or symbol placed before them to ensure 
AT users can also identify important information. Note, Important or * are common 
phrases and symbols that precede special content. 

• The context of the content must be taken into consideration when adding this 
information. For instance, it is not necessary to add textual meaning before one 
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bolded word in a sentence. Often words such as not are bolded and capitalized in the 
middle of a sentence. In most circumstances, it is probably not necessary to 
textually convey that that one word is emphasized. 

 

Setting Appropriate Color Contrast 

Providing sufficient color between foreground and background is important to many user 
groups but especially to those with low vision and color blindness. Color contrast applies to 
any text or images of text. Text styled below 18-point font must have a color contrast ratio 
of 4.5:1, unless bolded. Text styled at 18-point font or greater, or at least 14 point and 
bolded, must have a color contrast ratio of 3.0:1. Resources for verifying the contrast 
between foregrounds and backgrounds can be found under Color Resources on the VHA OHI 
508 Office’s Resources page. 

Examples of color contrast 

 

Changing the text color 

The easiest way to improve the contrast of text (not images of text) in a PDF document is to 
change the foreground color (or the color of the text itself). To change the color of the text 
in Acrobat X, follow the steps below. 

1. From the Tools pane, under Content, navigate to and activate the Edit Document 
Text option. 

2. Select (highlight) the text in the document which needs to be modified. 

3. If a TouchUp error dialog appears stating the some fonts are not available and a 
substitute is going to be used, navigate to and activate the OK button.  
 

http://www.ehealth.va.gov/508/resources_508.html
http://www.ehealth.va.gov/508/resources_508.html
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Most of the time the look and feel of the text is not modified in a manner that is 
disruptive. 

4. Activate the Context menu of the selected text, and select Properties… from the 
menu. 

5. Verify the Text tab is the active tab in the dialog. 

6. Navigate to and activate the Fill color-picker button and select a desirable color. 
 

 

7. Navigate to and activate the Close button. 

8. Verify the color of the selected text has changed in the document. 
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9. Perform appropriate tests to ensure the new foreground color meets sufficient 
contrast ratios in relationship to the background. 

10. Repeat the steps above to continue changing and verifying the contrast. 
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Constructing Accessible Tables 

Often tables are used in two ways: for layout purposes and to organize and display 
associated data. The use of layout tables should be limited. Layout tables can cause 
navigational issues for AT users. Layout tables should not contain data table structure, such 
as table header (TH) tags, for headers. 

There are two types of data tables: simple and complex. Simple data tables have a one-
column header to one-row header ratio. Complex data tables have two or more levels of 
row and/or column headers that must be associated to make sense. The following are some 
important keys to creating accessible data tables in Adobe Acrobat PDF documents: 

• Ensure data tables are formatted using table elements. 
• All data tables should use TH tags to identify header cells. 
• Define column headers across page breaks. 
• Associate table row and column headers with data cells. 
• Place content that is in separate rows and columns into separate data cells. 
• Merged row and column headers need to have RowSpan or ColSpan defined. 

Table Structure 
Using the below example of a three-column, two-row table, the structural elements and 
nesting of tags can demonstrate what the final proper structure of a table needs to appear 
as in the Tags pane. 

Example Table: 

Header 1 Text Header 2 Text Header 3 Text 

Row Header Text Column 2, row 2 data cell text Column 3, row 2 data cell text 

Example tag structure: 

• <Table> - Element definition, a table. 
o <TR> - Table Row  
 <TH> - Defines a table header cell 
• Header 1 text  

 <TH> - Defines second column header 
cell 
• Header 2 text 

 <TH> - Defines third column header cell 
• Header 3 text 

o <TR> - Table Row 
 <TH> - Defines the row header cell 
• Row header text 

 <TD> - Defines a table data cell 
• Column 2, row 2 data cell text 

 <TD> - Defines a table data cell 
• Column 3, row 2 data cell text 

Image of tag structure: 
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Other imperative structural modifications will not be visible in the Tags pane or within the 
table itself, but they are crucial in order for AT users to navigate and comprehend data table 
information. There are several steps involved to properly structure tables and associate data 
cells with table headers. To simplify the process, some step-by-step instructions have been 
provided in the simple tables, complex tables and spanned cells sections. 

Getting Started with the TouchUp Reading Order Tool 

The TURO tool can help get the table structuring process started. Further work will need to 
be done in the table editor and/or Tags pane to complete the process. 

One of the ways the TURO tool can help is if a table in the document has implicit structure. 
Sometimes instead of using proper table structure, tabbing or other kinds of spacing are 
used to visually imply a table, but AT users have no way to discern what information is 
related to one another. 

 

An implicit table will most likely be contained in Paragraph (<P>) tags in the Tags pane 
instead of the proper Table (<Table>) and associated tags. The TURO tool can get the basic 
structure inserted into the tags and mapped to the proper elements so that the object will 
be recognized as a table by AT. 

1. Navigate to and open the Tools pane. 

2. Locate and expand the options under Accessibility. 

3. Navigate to and activate the TURO tool. 

4. Confirm the TURO dialog appears. 

5. Select the content in the document that needs to have table structure applied. 

6. Navigate to and activate the Table button in the TURO dialog. 

7. Confirm an X appears over the content and the word Table is placed in the upper 
left corner of the object. 
 

 

8. Locate the table content in the Tags pane and confirm there are table structure 
tags present. 
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Simple Data Tables 

Activity Monday Tuesday Wednesday Thursday Friday 

Start Time 8 a.m. 8 a.m. 8 a.m. 8 a.m. 8 a.m. 

End Time 4:30 p.m. 4 p.m. 4:30 p.m. 4 p.m. 4 p.m. 

 
The above is an example of a simple data table of a work schedule. The table has six 
columns and three rows. The column headers are the days of the week Monday through 
Friday. The row headers are “Start Time” and “End Time”. Each day of the week has two 
times listed, one for when to be at work and one for when to leave. 

For simple data tables where there is a one-to-one relationship between a data cell and a 
row/column header, The Scope attribute can be used to associate the header with the cell. 
There are two methods to properly associate the cells; using the Table Editor features 
(recommended) or editing the properties of each cell through the Tags pane. The steps for 
both methods are explained below. 

Recommended Approach: Using the Table Editor: 

1. Activate the TURO tool under Accessibility in the Tools pane. 

2. Activate the Context menu of the table. 

3. Select Table Editor. 
 

 

4. Activate the Context menu of the table header cell that needs to be marked as a 
header. 

5. Select Table Cell Properties. 

6. Confirm the Table Cell Properties dialog appears. 
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7. Select the Header Cell radio button under Type in the dialog. 
 

 

8. Select the appropriate Scope - Row, Column or Both from the Scope combo box. 

9. Navigate to and activate the OK button. 

10. Repeat the process for each row and column header. 

Method Two: Editing Properties and Attribute Objects: 

1. Locate the header text in the Tags pane. 

2. Select Properties… from the Context menu. 

3. Confirm the TouchUp Properties dialog appears and that Tag is the active tab. 

4. Confirm Table Header Cell is selected in the Type combo box. 

5. Navigate to and activate the Edit Attribute Objects… button. 

6. Confirm the Attributes dialog appears. 

7. Expand all Attribute Objects. 

8. Navigate to and activate the New Item button. 
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9. Confirm and select the new item that begins with /O. 

a. If the /O item has /Layout after it, the item needs to be changed to Table so 
that the application can apply the proper structure. 

b. Navigate to and activate the Change Item button. 

c. Enter Table (case sensitive) in the Value edit field. 

d. Navigate to and activate the OK button. 

e. Confirm the item now reads /O /Table. 

10. Select the /Attribute Object 1 item. 

11. Navigate to and activate the New Item button again. 

12. Confirm the Add Key and Value dialog appears. 

13. Enter the value Scope (case sensitive) in the Key field. 

14. Enter the value Row, Column or Both (case sensitive) in the Value field. 

15. Select the value String in the Value Type combo box. 

16. Navigate to and activate the OK button. 

17. Confirm the structure of the Attributes dialog is: Attribute Objects, nested 
Attribute Objects 1, further nested /O /Table and /Scope (Row), /Scope (Column) 
or /Scope (Both). 



VHA Section 508 Office December 15, 2011 46 

 

 

18. Navigate to and activate the OK button in the Attributes dialog. 

19. Navigate to and activate the Close button in the TouchUp Properties dialog. 

20. Repeat this process for each row and column header. 
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Complex Data Tables 

The table below is a complex table listing employees and their status on projects. The table 
is a good example of complexity because the project titles are merged cells, with status 
definitions under each. Each employee’s status on a project is related to “Started” or 
“Completed” and the project title.  

Employee 
Project A Project B Project C 

Started Completed Started Completed Started Completed 

Maria Yes Yes Yes No No N/A 

John No N/A Yes Yes Yes No 

Jessica Yes No No N/A No N/A 

Complex tables, such as the one above, need ID and Header arrays to associate data cells 
with headers. Each header (TH) will be assigned a unique ID and each data cell (TD) will 
have an array that includes all of the ID values of the applicable header cells. There are two 
methods to properly associate the cells: using the Table Editor features (recommended) or 
editing the properties of each cell through the Tags pane. The steps for both methods are 
explained below: 

Rcommended Approach: Utilizing the Table Editor 

Setting the ID: 

1. Activate the TURO tool under Accessibility in the Tools pane. 

2. Activate the Context menu of the table. 

3. Select Table Editor. 

4. Select the table header cell to mark as a header and activate the Context menu. 

5. Choose Table Cell Properties… 

6. Ensure the Header Cell radio button is selected. 

7. Select Row, Column, or Both from the Scope combo box. 

8. Adjust the values in the Row Span and Column Span edit boxes as necessary. 

9. Enter a unique value in the ID field that identifies this header cell. 

 
 
Note: The value entered is not what will be read to the assistive technology user. 
It is basically a behind the scenes code name for the visually displayed content. 
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The trick is to remember the unique value so that it can be associated with the 
correct content in later steps. 

10. Activate the OK button. 

11. Repeat for each table header cell. 

Setting the headers array for each data cell: 

1. Activate the TURO tool under Accessibility in the Tools pane. 

2. Activate the Context menu of the table. 

3. Select Table Editor. 

4. Activate the Context menu of a data cell. 

5. Select Table Cell Properties… 

6. Ensure the Data Cell radio button is selected in the Table Cell Properties dialog. 

7. Adjust the values in the Row Span and Column Span edit boxes as necessary. 

8. Navigate to and activate the Add button  for the Associated Header Cell IDs: 
list box. 

9. Select the matching header cell ID from the Header ID: combo box in the Add 
Table Header ID dialog. 
 

 
 
IMPORTANT: Select the header IDs in such a manner that the order in the list 
box from top to bottom will be the reverse order in which the headers should be 
read. Using the example table above, the visually implied reading order of the 
headers for the first data cell would be Project A, Started, Maria; therefore, the 
first item in the list box needs to be Maria. 

10. Navigate to and activate the OK button. 

11. Add additional header attributes, as needed, for each cell that has multiple 
headers. 

12. When all header IDs have been added, all associated row and column headers 
should be listed in the Associated Header IDs list box. 
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13. When finished, navigate to and activate the OK button of the Table Cell 
Properties dialog. 

14. Repeat the steps above for each table data cell. 

Method Two: Editing the Tag Element 

Setting the ID: 

1. Locate the header text in the Tags pane. 

2. Select Properties… from the Context menu. 

3. Confirm the TouchUp Properties dialog appears and that Tag is the active tab. 

4. Confirm Table Header Cell is selected in the Type combo box. 

5. Navigate to and activate the Edit Tag button. 
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6. Select the Tag Element root node. 

 

7. Navigate to and activate the New Item button. 

8. Enter ID (case-sensitive) in the Key edit field. 

9. Enter a unique value in the Value edit field. 

      Note: The value entered is not what will be read to the AT user. It is basically a 
behind the scenes code name for the visually displayed content. The trick is to 
remember the unique value so that it can be associated with the correct content 
in later steps. 

10. Select String from the Value Type combo box. 

11. Navigate to and activate the OK button in the Add Key and Value dialog. 

12. Confirm an item appears under Tag Element that has the structure /ID 
(Unique_Value). 
 

 

13. Navigate to and activate the OK button in the Tag Element dialog. 

14. Navigate to and activate the Close button in the TouchUp Properties dialog. 

15. Repeat for each table header cell. 

Setting the headers array for each data cell: 

1. Locate the data cell text in the Tags pane. 

2. Select Properties… from the Context menu. 

3. Confirm the TouchUp Properties dialog appears and that Tag is the active tab. 
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4. Confirm Table Data Cell is selected in the Type combo box. 

5. Navigate to and activate the Edit Attribute Objects button. 

6. Select the Attribute Objects root node. 

7. Navigate to and activate the New Item button. 

8. Select and expand the newly created attribute object. 

9. Select the /O /Layout attribute. 

10. Navigate to and activate the Change Item button. 

11. Enter Table (case-sensitive) in the value field. 

12. Navigate to and activate the OK button. 

13. Confirm the item now reads /O /Table. 

14. Select the item that reads /Attribute Object 1. 

15. Navigate to and activate the New Item button. 

16. Enter Headers (case-sensitive) in the Key field. 

17. Navigate to and select Array from the Value Type combo box. 

18. Navigate to and activate the OK button. 

19. Select the /Headers [Array] attribute. 
 

 

20. Navigate to and activate the New Item button. 

21. Enter a header cell ID previously created into the Value edit field. The ID entered 
in this field is case sensitive and needs to be the exact, unique value previously 
created. 

22. Navigate to and select String from the Value Type combo box. 

23. Navigate to and activate the OK button. 

24. Add the additional header attributes to the array, as needed, for each cell that 
has multiple headers. 
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25. When all associated headers for one data cell have been added to the headers 
array, confirm there are multiple nested items under the /Headers [Array] item. 
 

 

26. When done with a data cell, navigate to and activate the OK button in the 
Attributes dialog. 

27. Navigate to and activate the Close button in the TouchUp Properties dialog. 

28. Repeat the steps to add the associated headers for each table data cell. 
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Spanned Cells 

It is crucial that spanned table headers and data cells have the appropriate ColSpan or 
RowSpan attributes applied for screen readers to properly interpret the information. Setting 
the proper value for ColSpan and/or RowSpan for header content that spans across multiple 
columns or rows allows ATs to identify the correct header name to the user. 

Best Approach: Updating Row Span and Column Span through the Table Editor: 

1. Activate the TURO tool under Accessibility in the Tools pane. 

2. Activate the Context menu of the table. 

3. Select Table Editor. 

4. Activate the Context menu. 

5. Choose Table Cell Properties… 

6. Ensure the Header Cell radio button is selected. 

7. Ensure the proper value is selected in the Scope: combo box, either Row, Column 
or Both. 

8. Adjust the values in the Row Span or Column Span edit boxes as necessary. The 
value in the edit field needs to equal the number of columns or rows that the text 
and cell boundaries spread across. In the example table used in the Complex 
Tables section, Project A spans two columns (Started and Completed); therefore, 
the value in the Col Span edit field for the Project A cell would be 2.  
 

 

9. Navigate to and activate the OK button. 

10. Repeat for each spanned table cell. 

Method 2: Editing Tag Attributes: 

1. Locate the data cell text in the Tags pane. 

2. Select Properties… from the Context menu. 

3. Confirm the TouchUp Properties dialog appears and that Tag is the active tab. 

4. Confirm Table Header Cell or Table Data Cell is appropriately selected in the Type 
combo box. 

5. Navigate to and activate the Edit Attribute Objects… button. 
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6. If the /O /Table item does not exist, one needs to be created. 

a. Navigate to and activate the New Item button. 

b. Expand the newly added Attribute Objects 1 item. 

c. Confirm a nested /O /Layout item is present. This item needs to be changed 
to Table so that the application can apply the proper structure. 

d. Select the /O /Layout item in the Attributes dialog. 

e. Navigate to and activate the Change Item button. 

f. Enter Table (case sensitive) in the Value edit field. 

g. Navigate to and activate the OK button. 

h. Confirm the item now reads /O /Table. 

7. Select the Attribute Object 1 item. 

8. Navigate to and activate the New Item button. 

9. Navigate to and enter ColSpan or RowSpan (case sensitive) as appropriate in the 
key field. 

10. Navigate to and enter the number of columns or rows spanned (Example: 2) in 
the Value edit field. 

11. Navigate to and select Integer from the value type field. 

12. Navigate to and activate the OK button. 

13. Confirm a new item appears in the Attributes dialog. Example: /ColSpan 2. 
 

 

14. Navigate to and activate the OK button. 

15. Repeat for each spanned table cell. 
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Helpful Table Editor Options 

 

By making some color and label selections in the Table Editor Options dialog, the current 
structure of the table can be more visually apparent. It may especially be beneficial to 
select a header cell color, check the checkbox and select a color for spanned cells, and to 
show the label for the cell type. 

 

Accessing and Using the Table Editor Options: 

1. Navigate to and open the Tools pane. 

2. Locate and expand the options under Accessibility. 

3. Navigate to and activate the TouchUp Reading Order (TURO) tool. 

4. Confirm the TURO dialog appears. 

5. In the document, activate the Context menu of any table. 

6. Navigate to and select Table Editor on the Context menu. 

7. Confirm the table editor is active by confirming the default red border appears 
around each table cell. 

8. Activate the Context menu of the table where the table editor is active. 
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9. Navigate to and select Table Editor Options… from the Context menu. 
 

 

10. Confirm the Table Editor Options dialog appears. 

11. Make the desired selections. 

12. Navigate to and activate the OK button when finished. 

13. Confirm the selections have been applied to the table where the table editor is 
active. 
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Designing Accessible Forms 

Electronic forms are an ever-growing method of retrieving information from consumers and 
participants. Forms contain a variety of elements and all must have accessibility attributes 
applied. Radio buttons, checkboxes, edit fields, submit and reset buttons, error messages, 
requirement constraints and many more items need proper labeling, grouping, instructions, 
and must be provided in a logical reading and tab order. Forms may seem like a complex 
topic, but managing each item individually simplifies the process of adding accessibility to a 
form. All step-by-step instructions in this topic are based on the features available in 
Acrobat Professional X. 

Structure and Best Practice 

The structure of form fields is actually quite simple. All that is required is a <Form> tag with 
a nested Field Name – OBJR tag. In the Tags pane the form tags need to appear after the 
tag containing the text label of the field. The <Form> tag distinguishes a type of element 
and allows AT to interpret how to handle the upcoming content. The Field Name – OBJR tag 
allows the field to be keyboard accessible. This is also where attributes, such as labels, need 
to be applied to make the field accessible.. 

 

It is best to not require a timed response on forms when possible. A disability can impact a 
person’s ability to navigate and fill out a form in a timely manner. Online auctions or 
activities, such as exams where the validity of the activity requires a time constraint, are 
exceptions to the rule. If it is necessary to require a time limit, the user should be permitted 
to turn off, adjust or extend the time allowance. If a mechanism is put in place to allow the 
user to extend the time, at least 10 seconds needs to be permitted for a response before 
the form expires. 

Positioning and Grouping 

Low vision users can have difficulty tracking items on the screen. Since they are only seeing 
a portion of their screen at any given time, it can be difficult to know where and whether 
actionable elements are present. Form elements need to be positioned to the left of each 
text label. When this is performed, users are able to track the items because the actionable 
elements are at the same position and spacing on each line. 

 

Left positioning is essential for checkboxes and radio buttons. Other form elements should 
be to the right of the label, such as edit fields, list boxes and drop-down boxes, most of the 
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time. These elements are usually found to the right of the label because they occupy 
different amounts of space; therefore, with them on the right the labels line-up. There are a 
few exceptions to the rule. As long as a search field properly indicates its purpose, a search 
edit field should be to the left of its corresponding button. In the case of drop-down boxes, 
depending on their purpose, they may be best served on the left or right. For example, a 
matching exercise where the answer options are A-E in the drop-down should appear to the 
left of its label. This is a valid practice because the form element is not utilizing a lot of 
space and all the controls will line up. 

Often related fields are visually grouped together on a page or duplicate fields are provided 
for different purposes, such as billing and shipping addresses. It is important to remember 
in PDF forms to add the visual group name to the beginning of the tooltip name. For 
example, a field’s proper tooltip would say “Billing First Name” or “Shipping Zip Code”. How 
to apply a tooltip is discussed in the Reading Order and Labeling section.  

 

Errors and Constraints 

Any instructions the user needs to follow in order to successfully complete the form should 
be placed at the beginning of the form so that all the requirements can be found in one 
location. Instructions placed after forms are often missed by assistive technology users. 
Required formats and types of data expected in fields should be included in the instructions. 

Color, text and symbols are often used to indicate constraints for a particular field. 
Constraints need to be placed in the tooltip (in addition to the field name) and beside the 
field. All date, phone number, abbreviation formatting, required field indicator or other 
constraints need to be textually provided and obvious to users. Using properties available in 
Acrobat, some form elements can be set as required fields so that data entered must be 
verified in order for the form to be submitted. To set a field as required: 

1. Navigate to Tools > Forms > Edit. 

2. Confirm a Tasks pane appears on the right and the fields become editable. 

 

3. Activate the Context menu of the desired field. 

4. Navigate to and activate Properties… 

5. Confirm the Field Properties dialog opens and the General tab is the active tab. 
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6. Locate the Common Properties section. 

7. Navigate to and activate the Required checkbox. 
 

 

8. Navigate to and activate the Close button. 

9. Confirm the field is now required by noting a red shaded background in Form 
Editing mode and a red colored outline around the required field in viewing mode. 
Fields not required have a black shaded background in editing mode and a black 
outline in viewing mode. NOTE: Since color is being used to indicate whether the 
field is required or not, remember to add a textual indicator such as an asterisk 
to tell users the field is required. 
 

 

10. Repeat steps for all required fields. 

If a character limit is placed on a field, a non-visual method needs to be provided to allow 
users, especially the blind and visually impaired, to know when the limit has been reached. 
An audio tone can be played to indicate the text limit has been exceeded. Additionally, the 
number of characters currently typed can be displayed to the user so they can determine 
how to refine their answer. 

 

It is good practice to include a means to allow users to review the content before final 
submission of the form occurs. Users should be given the ability to confirm the data entered 
to verify its accuracy. This user verification is especially important for forms dealing with 
health care, legal and financial matters. 

Forms that have required fields will traditionally use validation code to ensure mandatory 
constraints are met after the user submits a form to be processed. It is common to see any 
requirements not met displayed on the form, but how the information is displayed tends to 
vary. Sometimes the fields are highlighted using color, text is placed alongside the 
delinquent field, error information is listed at the top of the page or error descriptions are 
placed in an alert dialog. 
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The most effective way to convey error information if it is going to be placed directly on the 
page, as opposed to an alert dialog, is to place the error information at the top of the form 
once the user explicitly initiates submitting the form. The top of the form is defined as 
somewhere above the first input field. When error information is placed after a field or 
whole form, AT users are likely to be confused and miss the information. Error messages 
need to be prefaced by the word Error or with an error icon with Error as the alternate text. 
Additionally, error messages need to include an appropriate description of the problem and 
indicate how the user can determine where the error exists (i.e., field name, special 
character, etc.). 

 

Reading Order and Labeling 

Users with disabilities may either not have the dexterity to point a device at a specific area 
of the screen or they may not be able to see what is being pointed to using a pointing 
device, such as a mouse. Therefore, all actionable elements need to be able to receive 
keyboard focus. An easy way to determine whether a form element or link is keyboard 
accessible is by tabbing to each actionable item and manipulating or using the field in the 
intended manner (i.e., typing in the field or pressing Enter to perform an action). To place a 
field in the active tab order, ensure that it can be found in the Tags tree. Use the Find… 
option on the Context menu of any tag in the Tags pane. Select Unmarked Annotations from 
the Fin combo box and activate the Tag Element button for any actionable items that are 
found. 

Just as important as an actionable item being in the tab order is the order of the content 
itself. It is crucial that a logical order is used when ordering the contents of the page. The 
items need to be in order visually on the page and in the Tags pane. It is important that any 
fields that enable other fields based on a particular response are also logically placed in the 
order of the content. These fields also need to be after the field that caused the change, 
both visually and in the Tags pane. Placing instructional text near the field that enables 
another field(s) will help users know to expect more fields. When newly enabled fields are 
placed in the order ahead of the enabling field, users of assistive technology are likely to not 
know more fields appeared. 

To determine and re-order the fields, the best approach is to use the Fields pane when in 
edit mode. This method will only show the order of form elements. The Tags pane and 
Order pane can also be used to order content. These panes will allow ordering of all content 
– form elements, links, text, etc. The method of moving content is the same for all panes. 

Recommended Approach: 

1. Navigate to and activate Tools. 

2. Select the Forms section. 
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3. Navigate to and activate Edit. 

4. Confirm edit mode is active by noting Tasks and Fields panes appear on the right. 

5. Navigate to the Fields pane. 

6. Activate the Tab Order sub-menu and select Order Tabs by Structure. This is the 
first step to ensuring the order of the content is logical. Once the tags are 
manipulated manually this selection will automatically be changed to Order Tabs 
Manually. 
 

 

7. Review the top to bottom order of the fields listed in the Fields pane and 
determine if the fields need to be rearranged. This can be done by comparing the 
order seen in the Fields pane and reviewing the actionable fields highlighted in 
the main document area. 

8. If the fields need to be rearranged, highlight the desired field and drag the field 
into the correct location (before, in between or after another field). Note: Cut and 
paste is not available to move tags in this view as it is in the Tags pane. 
 

 

9. Repeat until all fields are in appropriate order. 

10. Navigate to and open the Tags pane. 

11. Confirm all elements are in the proper order. Remember the Tags pane ultimately 
dictates the reading order for AT users. It is possible that although tags were 
rearranged in the form field Tab Order pane, they were not automatically moved 
in the main tag structure. 
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Each form field needs to be properly identified so that the meaning and purpose is clear to 
all users. Without proper labeling, users of AT can easily mistake one field for another or the 
AT might guess a label incorrectly. Often form fields that reside within tables have multiple 
labels associated with them. When providing information about a form field be sure to 
provide information about all group names, field names and constraints information. A 
tooltip with all necessary information needs to be applied to each form field to properly label 
the field. To apply a tooltip: 

1. Navigate to and activate Tools. 

2. Select the Forms section. 

3. Navigate to and activate Edit. 

4. Confirm edit mode is active by noting Tasks and Fields panes appear on the right. 

5. Activate the Context menu of the desired field. 

6. Navigate to and activate Properties… 

7. Confirm the Field Properties dialog appears and the General tab is the active tab. 

8. Navigate to the Tooltip edit field. 

9. Enter all group names, field names and constraint information into the field. 
 

 

10. Navigate to and activate the Close button. 

11. Navigate to and activate the Close Form Editing button under the Tasks pane. 

12. Confirm the tooltip was applied to the field by hovering the pointer over the field 
where the tooltip was just applied. 
 

 

13. Repeat the steps for all form fields. 

When using radio buttons, ensure a unique name is provided to the group of radio buttons. 
When radio buttons are not grouped properly, assistive technology users have difficulty 
determining the relationship to other radio buttons. It also may be difficult to access these 
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unassociated radio buttons via the keyboard. The group name for a set of radio buttons 
should be the same for each button within the group. This group name is not displayed to 
the user and is not the same as the tooltip. To ensure a radio button group name is already 
applied or to apply one: 

1. Navigate to and activate Tools. 

2. Select the Forms section. 

3. Navigate to and activate Edit. 

4. Confirm edit mode is active by noting Tasks and Fields panes appear on the right. 

5. Activate the Context menu of the desired field. 

6. Navigate to and activate Properties… 

7. Confirm the Field Properties dialog appears and the General tab is the active tab. 

8. Navigate to the Name edit field. 

9. Enter a phrase that will be used for all radio buttons in the same group. For 
example, when offering two radio buttons for Male and Female, the group name 
could be Gender. 

10. Navigate to and activate the Close button. 

11. Repeat the steps to apply the group name to all radio buttons within the group. 

12. Navigate to and activate the Close Form Editing button under the Tasks pane. 

13. Confirm the group name was applied by tabbing to the first radio button in the 
group. 

14. Once focus is on the first radio button in the group, use the arrow keys on the 
keyboard to cycle through all the radio buttons. If only the radio buttons that are 
supposed to be associated to one another gain focus within the cycle, then all 
radio buttons in the group are properly associated. For example, only Male and 
Female should gain focus within the cycle. The age range 24-27 in a nearby 
question should not gain focus. 

Creating an Electronic Form 

For the purposes of this tutorial, an existing PDF file will be used to create an electronic 
form from scratch. It will be assumed the file has no prior electronic form fields present. An 
example may be a hardcopy form that has been scanned and run through the OCR process. 
This section will cover the various form fields available for use within Acrobat and the step-
by-step process of adding the fields into an existing PDF file. This section will cover the 
common types of elements found within forms and how to apply accessibility concepts to 
each type of element. 
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Automatically Create Form Structure 

1. In Acrobat open the desired PDF file that needs to become an electronic form. 

2. Locate and activate Tools to display the tools pane. 

3. Navigate to and expand the Forms menu. 

4. Navigate to and activate the Create button. 

5. Confirm the Create or Edit Form dialog appears. 
 

 

6. Navigate to and select the Use an Existing File radio button. 

7. Navigate to and activate the Next button. 

8. Confirm the Use the Current Document radio button is selected. 

9. Navigate to and activate the Next button. 

10. Navigate to and activate the Save button. 

11. Confirm the Forms toolbar is present. Form editing mode will be active. Fields in 
the document will also likely appear to contain editable elements. 
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Text Fields 

The first form field to discuss is the text edit field. Text fields are added within PDF where a 
free form response is entered by the user. Text fields can be used for entering one or more 
words in the field. 

1. With form editing mode active, locate and activate the Add New Field button. 

2. Select Text Field from the sub-menu options. 



VHA Section 508 Office December 15, 2011 66 

3. Using the mouse, select a location within the PDF file to add the text box, to the 
right or beneath the identifying text for the field. 

4. Activate the Context menu of the text box that was just added. 

5. Select Properties… and confirm the Text Field Properties dialog appears. 
 

 

6. Confirm the General tab is the active tab. 

7. Navigate to the Name edit field and replace the name of the text field with a 
more appropriate phrase. For example, Billing Street Address or Billing City. The 
name field is where group names and other important identifying information 
should be added. The name of a field is not shown to the user. 

8. Navigate to and enter a description of the text edit field in the Tooltip field. The 
tooltip is what associates the field to its neighboring label and may provide 
additional information to the user about the field. The tooltip is interpreted by AT 
or is displayed when the mouse is hovered over the field. The tooltip must include 
all group names, field names and any constraint information to be provided to 
the user. 

9. If applicable, navigate to and activate the Required checkbox for text fields that 
are required. 

10. Navigate to and activate the Options tab. 

11. Navigate to the Alignment dropdown and select a desired alignment. 

12. Navigate to the Default Value edit field and if desired enter a phrase to be 
displayed in the field when the form opens. Leave this field blank to not have any 
text appear in the field by default. 

13. For text edit fields where long responses are expected, such as Comments fields, 
it may be desirable to navigate to and select the Multi-Line checkbox so that 
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more of a user’s response is visible at once, which makes it easier for them to 
modify. 

a. If Multi-Line is a desired attribute of the field, it would be most beneficial to 
the user for the Scroll Long Text checkbox is also selected. 

b. If a limited response is required, navigate to and activate the Limit of 
checkbox. Then navigate to and enter a value in the characters edit field. 

14. Navigate to and select the Check Spelling checkbox. 

15. Add additional attributes through the other tabs in the dialog as necessary. 

16. Navigate to and activate the Close button. 

17. Confirm the name of the field has been added by viewing the name of the field 
displayed within the main document area. 
 

  
The tooltip can be confirmed by navigating to and activating the Close Form 
Editing button in the Tasks pane and placing the pointer over the modified field. 

18. Repeat steps to add names and tooltips to all text edit fields in the document. 

Checkboxes 

Checkboxes are useful in creating a list of items where zero or more items can be selected 
at once. In contrast to radio buttons where the user can only select one item, the checkbox 
field provides the user with the ability to select one or more items. 

1. With form editing mode active, locate and activate the Add New Field button. 

2. Select Check Box from the sub-menu. 

3. Using the mouse, select a location within the main document to add the 
checkbox. It is most appropriate to add a checkbox to the left of its on-screen 
label, if possible. 

4. Activate the Context menu of the newly added checkbox and select Properties... 

5. Confirm the Check Box Properties dialog appears and General is the active tab. 

6. Navigate to the Name edit field and replace the name of the checkbox with a 
more appropriate phrase. The name field is where group names and other 
important identifying information should be added. The name of a field is not 
displayed to the user. 

7. Navigate to and enter a description of the checkbox in the Tooltip field. The 
tooltip is what associates the field to its neighboring label and may provide 
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additional information to the user about the field. The tooltip is interpreted by 
assistive technology or is displayed when the mouse is hovered over the field. 
The tooltip must include all group names, field names and any constraint 
information to be provided to the user. 

8. If applicable, navigate to and activate the Required checkbox for checkboxes that 
are required. 

9. Navigate to and select the Options tab. 

10. If desired, navigate to and select the Check Box is Checked by Default checkbox 
if a pre-determined answer needs to be selected when the form is opened. 

11. Add additional attributes through the other tabs in the dialog as necessary. 

12. Navigate to and activate the Close button. 

13. Confirm an editable checkbox appears next to its associated label. 
 

 

14. Repeat steps to add more checkboxes. 

Radio Buttons 

Radio buttons are used to make a list of items where only one item can be selected from the 
list. They are useful in short lists or for Yes or No types of questions. All radio buttons within 
a group must share the same group name but have an individual name for each button 
choice. 

1. With form editing mode active, locate and activate the Add New Field button. 

2. Select Check Box from the sub-menu. 

3. Using the mouse, select a location within the main document to add the radio 
button. It is most appropriate to add a radio button to the left of its on-screen 
label if possible. 

4. Activate the Context menu of the newly added radio button and select 
Properties... 

5. Confirm the Radio Button Properties dialog appears and General is the active tab. 

6. Navigate to the Name edit field and replace the text with an appropriate group 
name for the radio buttons. For example, if the related radio buttons are 
individually named Red, Blue and Green, an appropriate group name would be 
Favorite Color. The name of a field is not displayed to the user. 

7. Navigate to and enter a description of the individual radio button (ex. Favorite 
Color - Red) in the Tooltip field. The tooltip is what associates the field to its 
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neighboring label and may provide additional information to the user about the 
field. The tooltip is interpreted by assistive technology or is displayed when the 
mouse is hovered over the field. The tooltip must include all group names, field 
names and any constraint information to be provided to the user. 

8. If applicable, navigate to and activate the Required checkbox for radio buttons 
that are required. 

9. Navigate to and select the Options tab. 

10. If desired, navigate to and select the Button is Selected by Default checkbox if a 
pre-determined answer needs to be selected when the form is opened. 
 

 

11. Add additional attributes through the other tabs in the dialog as necessary. 

12. Navigate to and activate the Close button. 

13. Confirm an editable radio button appears next to its associated label. 

14. Repeat steps to add more radio buttons. Reminder: The group name must be 
exactly the same for all radio buttons contained within one group. 

Dropdowns 

A dropdown menu, also commonly referred to as a combo box, is useful for selecting one 
value from a list without on-screen real estate. A best practice for dropdown lists is to make 
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the default choice an instruction, such as “Select an Option”. This instruction will provide 
users with more instruction and information about what is expected. 

1. With form editing mode active, locate and activate the Add New Field button. 

2. Select Dropdown from the sub-menu. 

3. Using the mouse, select a location within the main document to add the 
dropdown. 

4. Activate the Context menu of the newly added dropdown and select Properties... 

5. Confirm the Dropdown Properties dialog appears and General is the active tab. 

6. Navigate to the Name edit field and replace the text with an appropriate phrase 
to categorize the dropdown list. The name of a field is not displayed to the user. 

7. Navigate to and enter a description of the dropdown list (likely similar to the 
Name of the field) in the Tooltip field. The tooltip is what associates the field to 
its neighboring label and may provide additional information to the user about 
the field. The tooltip is interpreted by assistive technology or is displayed when 
the mouse is hovered over the field. The tooltip must include all group names, 
field names and any constraint information to be provided to the user. 

8. If applicable, navigate to and activate the Required checkbox for radio buttons 
that are required. 

9. Navigate to and select the Options tab. 

10. Locate the Item edit field and add text for the first item to be displayed in the 
dropdown. 
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11. Navigate to and activate the Add button. 

12. Repeat the previous two steps to create the item list. 

13. From the Items List field, select an item to be selected by default if desired. 
Instructional text such as “select an item from the list below” can be a helpful 
way to provide additional instructions to the user. 

14. Navigate to and select the Check Spelling checkbox. 

15. Navigate to and select the Sort items checkbox. 

16. Add additional attributes through the other tabs in the dialog as necessary. 

17. Navigate to and activate the Close button. 

18. Confirm an editable dropdown has been added near its associated label. 

Buttons 

Buttons are used to trigger an action. It can be used to open a link, submit a form or play 
media. Since there are such diverse uses for buttons it is very important to provide 
distinctive information about the purpose of the button through its visible name. 
Occasionally it is necessary to provide additional information through the tooltip of the 
button to clarify instructions and purpose. Making the name of a button clearer is important 
for all users. 
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1. With form editing mode active, locate and activate the Add New Field button. 

2. Select Button from the sub-menu. 

3. Using the mouse, select a location within the main document to add the button. 

4. Activate the Context menu of the newly added button and select Properties... 

5. Confirm the Button Properties dialog appears and General is the active tab. 

6. Navigate to the Name edit field and replace the text with an appropriate phrase 
to call the button. The name of a field is not displayed to the user. 

7. Navigate to and enter a description of the button (likely similar to the Name of 
the field) in the Tooltip field. The tooltip is what associates the field to its 
neighboring label and may provide additional information to the user about the 
field. The tooltip is interpreted by assistive technology or is displayed when the 
mouse is hovered over the field. The tooltip must include all group names, field 
names and any constraint information to be provided to the user. 

8. Navigate to and select the Options tab. 

9. Navigate to the Layout dropdown and select Label Only from the options. Note: 
Adding an icon to a button may cause accessibility issues. 

10. Navigate to Behavior dropdown and select an appropriate behavior for the button 
from the list. Note: Most buttons have the behavior of Push for an action such as 
submissions. 
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11. Navigate to the State list box and select an appropriate state from the list. 

12. Navigate to the Label edit field and enter the desired text that will appear on the 
button. 

13. Navigate to and select the Actions tab. 

14. Navigate to the Select Trigger dropdown and select an appropriate trigger 
function for the button. Note: Most buttons are triggered by the Enter key on the 
keyboard or by the left button on a mouse. 
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15. Navigate to the Select Action dropdown and select an appropriate action that the 
trigger of the button will produce. Note: Most buttons are used to submit forms, 
play media and/or open a link. 

16. Navigate to and activate the Add button. 

17. Apply appropriate attributes for the chosen action(s). 

18. Add additional attributes through the other tabs in the dialog as necessary. 

19. Navigate to and activate the Close button. 

20. Confirm an editable button has been added in the main document area. 

21. Repeat the steps to add more buttons to the document. 

 

Our VHA Section 508 Office is happy to help you with any questions. Please feel free to 
contact us at VHA10P7ASection508@va.gov. 

mailto:VHA10P7ASection508@va.gov
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